
Q .1Q .1 A cc ording to  the 2 0 1 1  C ens us  of Ind ia ,  what was  the populat ion growth rate rec orded for  the Hindu rel igion?A cc ording to  the 2 0 1 1  C ens us  of Ind ia ,  what was  the populat ion growth rate rec orded for  the Hindu rel igion?

A nsA ns 1. 10.45%

2. 20.23%

3. 27.09%

4. 16.8%

Q .2Q .2 When was  the G andhi- Irwin Pac t  s igned by  G andhi j i  on behalf  of  the C ongres s  and L ord Irwin on behalf  of  the Br it is h G overnment?When was  the G andhi- Irwin Pac t  s igned by  G andhi j i  on behalf  of  the C ongres s  and L ord Irwin on behalf  of  the Br it is h G overnment?

A nsA ns 1. 10 January 1931

2. 15 February 1931

3. 20 April 1931

4. 5 March 1931

Q .3Q .3 Whic h Indian s tate has  the lowes t  s ex rat io ,  acc ording to  2 0 1 1  C ens us?Whic h Indian s tate has  the lowes t  s ex rat io ,  acc ording to  2 0 1 1  C ens us?

A nsA ns 1. 

2. 

3. 

4. 

Q .4Q .4 Whic h of the fo l lowing C ons t itut ional  A mendment A c ts  made it  a  Fundamental  Duty  of parents  to  provide educ at ion to  theirWhic h of the fo l lowing C ons t itut ional  A mendment A c ts  made it  a  Fundamental  Duty  of parents  to  provide educ at ion to  their
c hi ldren aged 6- 1 4  y ears?c hi ldren aged 6- 1 4  y ears?

A nsA ns 1. 45th  Constitutional Amendment

2. 42nd  Constitutional Amendment

3. 86th  Constitutional Amendment

4. 78th  Constitutional Amendment

Q . 5Q . 5 When was  the Federal  C ourt  of  Ind ia  es tabl is hed?When was  the Federal  C ourt  of  Ind ia  es tabl is hed?

A nsA ns 1. 1930

2. 1937

3. 1925

4. 1919

Q .6Q .6 Whic h of the fo l lowing High C ourts  in O c tober  2 0 24  had held  that  the V ic t im A s s is tance S c heme for  rape s urv ivors  c an be appl iedWhic h of the fo l lowing High C ourts  in O c tober  2 0 24  had held  that  the V ic t im A s s is tance S c heme for  rape s urv ivors  c an be appl ied
retros pec t ively ?retros pec t ively ?

A nsA ns 1. Hon’ble Bombay High Court

2. Hon’ble Delhi High Court

3. Hon’ble Punjab and Haryana High Court

4. Hon’ble Rajasthan High Court

Q .7Q .7 In Par l iamentary  proceedings ,  how many  s tarred ques t ions  are inc luded in the l is t  of  bus ines s  for  oral  ans wers  in both Hous es  eac hIn Par l iamentary  proceedings ,  how many  s tarred ques t ions  are inc luded in the l is t  of  bus ines s  for  oral  ans wers  in both Hous es  eac h
day ?day ?

A nsA ns 1. 20

2. 30

3. 10

4. 25

Test Date 20/06/2025
Test Time 9:00 AM - 10:30 AM
Subject Correspondence Clerk and Store Assistant
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Q .8Q .8 Whic h team was  a  runner- up in the U- 1 9 C r ic ket  World  C up 2 0 24 ?Whic h team was  a  runner- up in the U- 1 9 C r ic ket  World  C up 2 0 24 ?

A nsA ns 1. Australia

2. Bangladesh

3. Sri Lanka

4. India

Q .9Q .9 Whic h of the fo l lowing rel igious  groups  in Ind ia  has  the lowes t  percentage of other  bac kward c las s es?Whic h of the fo l lowing rel igious  groups  in Ind ia  has  the lowes t  percentage of other  bac kward c las s es?

A nsA ns 1. Jains

2. Christians

3. Buddhists

4. Hindus

Q .1 0Q .1 0 In 2 0 24 ,  whic h c ountry  as s umed the c hairmans hip of BRIC S ?In 2 0 24 ,  whic h c ountry  as s umed the c hairmans hip of BRIC S ?

A nsA ns 1. India

2. South Africa

3. China

4. Russia

Q .1 1Q .1 1 A s  of November 2 0 24 ,  the National  Q uantum M is s ion's  objec t ive inc ludes  developing intermediate- s c ale quantum c omputers  withA s  of November 2 0 24 ,  the National  Q uantum M is s ion's  objec t ive inc ludes  developing intermediate- s c ale quantum c omputers  with
50 - 1 0 0 0  phy s ic al  qubits  in ______ y ears  in var ious  platforms  l ike s uperc onduc ting and photonic  tec hnology .50 - 1 0 0 0  phy s ic al  qubits  in ______ y ears  in var ious  platforms  l ike s uperc onduc ting and photonic  tec hnology .

A nsA ns 1. 5

2. 10

3. 8

4. 6

Q .1 2Q .1 2 In whic h s tate of Ind ia  is  the S undarbans  bio- res erve loc ated?In whic h s tate of Ind ia  is  the S undarbans  bio- res erve loc ated?

A nsA ns 1. Karnataka

2. West Bengal

3. Kerala

4. Odisha

Q .1 3Q .1 3 Whic h of the fo l lowing l iberal  leaders  of  the c ongres s  is  related to  the foundation of 'The S ervants  of Ind ia  S oc iety '  in 1 90 5?Whic h of the fo l lowing l iberal  leaders  of  the c ongres s  is  related to  the foundation of 'The S ervants  of Ind ia  S oc iety '  in 1 90 5?

A nsA ns 1. Keshab Chandra Sen

2. Mahatma Gandhi

3. Raja Ram Mohan Roy

4. Gopal Krishna Gokhale

Q .1 4Q .1 4 In ________ ,  V iceroy  C urzon part it ioned Bengal .In ________ ,  V iceroy  C urzon part it ioned Bengal .

A nsA ns 1. 1907

2. 1905

3. 1903

4. 1909

Q .1 5Q .1 5 In whic h phy s iographic  d iv is ion of Ind ia  are the ‘Kot l i  Dun’ and ‘Pat l i  Dun’ rel ief  features  found?In whic h phy s iographic  d iv is ion of Ind ia  are the ‘Kot l i  Dun’ and ‘Pat l i  Dun’ rel ief  features  found?

A nsA ns 1. The Coastal Plains

2. The Islands

3. The Himalayan Mountains

4. The Peninsular Plateau

Q .1 6Q .1 6 When would  V igi lance A warenes s  Week  2 0 24  be obs erved?When would  V igi lance A warenes s  Week  2 0 24  be obs erved?

A nsA ns 1. From 28 November 2024 to 3 December 2024

2. From 8 November 2024 to 14 November 2024

3. From 28 October 2024 to 3 November 2024

4. From 8 December 2024 to 14 December 2024
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Q .1 7Q .1 7 Whic h of the fo l lowing is  INCO RRE C T regarding fundamental  dut ies?Whic h of the fo l lowing is  INCO RRE C T regarding fundamental  dut ies?

A nsA ns 1. Added through 44th  Amendment

2. Added through 42nd  Amendment

3. Added in Part IV-A

4. Added in Article 51A

Q .1 8Q .1 8 Who among the fo l lowing wrote the Tamil  vers ion of the Ramay ana in the 1 2Who among the fo l lowing wrote the Tamil  vers ion of the Ramay ana in the 1 2t ht h  C entury  C E ? C entury  C E ?

A nsA ns 1. Jayadev

2. Vishakhadatta

3. Andal

4. Kamban

Q .1 9Q .1 9 How muc h of Khums  was  c ons idered as  war  booty  dur ing the Delhi  S ultanate?How muc h of Khums  was  c ons idered as  war  booty  dur ing the Delhi  S ultanate?

A nsA ns 1. One-third

2. One-sixth

3. One-fifth

4. One-tenth

Q .2 0Q .2 0 In June 2 0 24 ,  whic h of the fo l lowing c ountr ies  from A fr ic a won a non- permanent s eat  on the United Nations  S ec ur ity  C ounc i l?In June 2 0 24 ,  whic h of the fo l lowing c ountr ies  from A fr ic a won a non- permanent s eat  on the United Nations  S ec ur ity  C ounc i l?

A nsA ns 1. Somalia

2. Kenya

3. Zambia

4. Sudan

Q .2 1Q .2 1 Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .  ( A l lRefer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .  ( A l l
numbers  are s ingle- d igit  numbers  only . )numbers  are s ingle- d igit  numbers  only . )
( L eft)  4  ( L eft)  4  2  2  1  1  5 5 7  7  9  9  8  8  5 5 3  3  6  6  2  2  1  1  5 5 7  7  3  3  7  7  8  8  4  4  3  3  6  6  9  9  7  7  4  4  5 5 2  2  4  4  1  ( Right)1  ( Right)

How many  even numbers  are there in the number s er ies  between the number whic h is  eighth from the r ight  end and s ixth from theHow many  even numbers  are there in the number s er ies  between the number whic h is  eighth from the r ight  end and s ixth from the
left  end of the s er ies?left  end of the s er ies?

A nsA ns 1. Four

2. Five

3. Two

4. None

Q .2 2Q .2 2 Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .
(C ounting to  be done from left  to  r ight  only . )(C ounting to  be done from left  to  r ight  only . )
( L eft)  P  J  V  N L  G  T  E  W S  Q  O  R I  U X  M  C  H D K ( Right)( L eft)  P  J  V  N L  G  T  E  W S  Q  O  R I  U X  M  C  H D K ( Right)
How many  c ons onants  in the given s er ies  are immediately  preceded by  a  vowel  and immediately  fo l lowed by  a  vowel  as  wel l?How many  c ons onants  in the given s er ies  are immediately  preceded by  a  vowel  and immediately  fo l lowed by  a  vowel  as  wel l?

A nsA ns 1. Four

2. Three

3. Two

4. One

Q .2 3Q .2 3 If  the letters  in the word FE M ININE  are rearranged acc ording to  the E ngl is h a lphabetic al  order,  then how many  letters  wi l l  retainIf  the letters  in the word FE M ININE  are rearranged acc ording to  the E ngl is h a lphabetic al  order,  then how many  letters  wi l l  retain
their  or iginal  pos it ion?their  or iginal  pos it ion?

A nsA ns 1. One

2. Two

3. Zero

4. Three

Section : Logical Reasoning
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Q .24Q .24 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

1 60 ,  1 62 ,  1 67,  1 77,  1 94 ,  ?1 60 ,  1 62 ,  1 67,  1 77,  1 94 ,  ?

A nsA ns 1. 220

2. 215

3. 209

4. 210

Q .2 5Q .2 5 In the fo l lowing number- pairs ,  the s ec ond number is  obtained by  apply ing certain mathematic al  operat ions  to  the firs t  number.In the fo l lowing number- pairs ,  the s ec ond number is  obtained by  apply ing certain mathematic al  operat ions  to  the firs t  number.
S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .  S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .  

72 ,  9672 ,  96
4 8,  724 8,  72

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  its  c ons t ituent d igits .  E .g .( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  its  c ons t ituent d igits .  E .g .
1 3  – O perat ions  on 1 3  s uc h as  adding /  s ubtrac t ing /mult iply ing etc .  to  1 3  c an be performed.  Break ing down 1 3  into  1  and 3  and then1 3  – O perat ions  on 1 3  s uc h as  adding /  s ubtrac t ing /mult iply ing etc .  to  1 3  c an be performed.  Break ing down 1 3  into  1  and 3  and then
performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )  performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )  

A nsA ns 1. 86, 108

2. 98, 74

3. 39, 117

4. 91, 115

Q .2 6Q .2 6 S elec t  the c orrec t  mirror  image of the given figure when the mirror  is  placed at  XY  as  s hown below.S elec t  the c orrec t  mirror  image of the given figure when the mirror  is  placed at  XY  as  s hown below.

A nsA ns 1. 

2. 

3. 

4. 

Q .2 7Q .2 7 If  3  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the number 1 53 64 83 2 ,  how many  d igits  wi l l  appear  moreIf  3  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the number 1 53 64 83 2 ,  how many  d igits  wi l l  appear  more
than once in the new number thus  formed?than once in the new number thus  formed?

A nsA ns 1. Three

2. Two

3. Four

4. One

Q .2 8Q .2 8 Five people,  P,  Q ,  R,  S,  and T,  are s tanding in a  queue,  a l l  fac ing north,  one behind the other  in random order.  P  is  neither  firs t  norFive people,  P,  Q ,  R,  S,  and T,  are s tanding in a  queue,  a l l  fac ing north,  one behind the other  in random order.  P  is  neither  firs t  nor
las t  in the queue,  but  is  ahead of T.  R s tands  immediately  behind S.  S  is  ahead of P.  Q  is  at  the las t  pos it ion of the queue.las t  in the queue,  but  is  ahead of T.  R s tands  immediately  behind S.  S  is  ahead of P.  Q  is  at  the las t  pos it ion of the queue.
What is  the pos it ion of P  in the queue?What is  the pos it ion of P  in the queue?

A nsA ns 1. Third from the front

2. First from the front

3. Fourth from the front

4. Second from the front

Q .2 9Q .2 9 72  is  related to  1 84  fo l lowing a certain logic .  Fo l lowing the s ame logic ,  96  is  related to  2 0 8 .  To  whic h of the given options  is  1 4 872  is  related to  1 84  fo l lowing a certain logic .  Fo l lowing the s ame logic ,  96  is  related to  2 0 8 .  To  whic h of the given options  is  1 4 8
related ,  fo l lowing the s ame logic ?related ,  fo l lowing the s ame logic ?

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their  c ons t ituent d igits .( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their  c ons t ituent d igits .
E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into  1  and 3  and thenE .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into  1  and 3  and then
performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )

A nsA ns 1. 260

2. 262

3. 278

4. 271
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Q .3 0Q .3 0 Three of the fo l lowing four  word- pairs  are a l ike in a  certain way  and thus  form a group.  Whic h word- pair  DO E S  NO T belong to  thatThree of the fo l lowing four  word- pairs  are a l ike in a  certain way  and thus  form a group.  Whic h word- pair  DO E S  NO T belong to  that
group?group?

( NO TE :  The words  mus t be c ons idered as  meaningful  E ngl is h words  and mus t not  be related to  eac h other  bas ed on the number of( NO TE :  The words  mus t be c ons idered as  meaningful  E ngl is h words  and mus t not  be related to  eac h other  bas ed on the number of
letters  /number of c ons onants/vowels  in the word . )letters  /number of c ons onants/vowels  in the word . )

A nsA ns 1. Rickets : Vitamins

2. Goitre : Iodine

3. Anaemia : Iron

4. Scurvy : Blood

Q .3 1Q .3 1 C  is  the brother  of B.  W is  the daughter  of P.  K  is  the daughter  of B.  N is  the hus band of P.  W is  the wife of B.  How is  W related to  C ?C  is  the brother  of B.  W is  the daughter  of P.  K  is  the daughter  of B.  N is  the hus band of P.  W is  the wife of B.  How is  W related to  C ?

A nsA ns 1. Brother’s daughter

2. Wife’s father 

3. Wife’s brother

4. Brother’s wife 

Q .3 2Q .3 2 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ters  are a l ike in a  certain way  and thus  form a group.Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ters  are a l ike in a  certain way  and thus  form a group.
Whic h letter- c lus ter  DO E S  NO T belong to  that  group?  Whic h letter- c lus ter  DO E S  NO T belong to  that  group?  
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )

A nsA ns 1. TOR

2. KFH

3. QLN

4. NIK

Q .3 3Q .3 3 If  2  is  added to  eac h even d igit  and 1  is  s ubtrac ted from eac h odd d igit  in the number 93 52 674 ,  whic h of the fo l lowing d igits  wi l l  beIf  2  is  added to  eac h even d igit  and 1  is  s ubtrac ted from eac h odd d igit  in the number 93 52 674 ,  whic h of the fo l lowing d igits  wi l l  be
third  from the r ight  in the new number thus  formed?third  from the r ight  in the new number thus  formed?

A nsA ns 1. 5

2. 6

3. 8

4. 2

Q .3 4Q .3 4 FA  1 2  is  related to  C X 2 0  in a  certain way .  In the s ame way ,  DY  4 9 is  related to  AV  57.  To  whic h of the fo l lowing is  KF 62  related ,FA  1 2  is  related to  C X 2 0  in a  certain way .  In the s ame way ,  DY  4 9 is  related to  AV  57.  To  whic h of the fo l lowing is  KF 62  related ,
fo l lowing the s ame logic ?fo l lowing the s ame logic ?

A nsA ns 1. GC 70

2. HC 70

3. HB 72

4. GB 72

Q .3 5Q .3 5 E ac h vowel  in the word TE M PL E  is  c hanged to  the letter  immediately  fo l lowing it  in the E ngl is h a lphabetic al  order  and eac hE ac h vowel  in the word TE M PL E  is  c hanged to  the letter  immediately  fo l lowing it  in the E ngl is h a lphabetic al  order  and eac h
c ons onant is  c hanged to  the letter  immediately  preceding it  in the E ngl is h a lphabetic al  order.  Whic h of the fo l lowing letters  wi l l  bec ons onant is  c hanged to  the letter  immediately  preceding it  in the E ngl is h a lphabetic al  order.  Whic h of the fo l lowing letters  wi l l  be
fourth from the left  in the group of letters  thus  formed?fourth from the left  in the group of letters  thus  formed?

A nsA ns 1. M

2. Q

3. P

4. O

Q .3 6Q .3 6 C RA C K is  related to  G V E G O  in a  certain way  bas ed on the E ngl is h a lphabetic al  order.  In the s ame way ,  DE ATH is  related to  HIE XL .  ToC RA C K is  related to  G V E G O  in a  certain way  bas ed on the E ngl is h a lphabetic al  order.  In the s ame way ,  DE ATH is  related to  HIE XL .  To
whic h of the given options  is  TO TA L  related ,  fo l lowing the s ame logic ?  whic h of the given options  is  TO TA L  related ,  fo l lowing the s ame logic ?  

A nsA ns 1. 

2. 

3. 

4. 
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Q .3 7Q .3 7 If  2  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the number 1 783 564 ,  how many  d igits  wi l l  appear  moreIf  2  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the number 1 783 564 ,  how many  d igits  wi l l  appear  more
than once in the new number thus  formed?than once in the new number thus  formed?

A nsA ns 1. Two

2. None

3. Three

4. One

Q .3 8Q .3 8 FE  3 6 is  related to  IH  4 4  in a  certain way .  In the s ame way ,  KJ  51  is  related to  NM  59 .  To  whic h of the given options  is  RQ  63  related ,FE  3 6 is  related to  IH  4 4  in a  certain way .  In the s ame way ,  KJ  51  is  related to  NM  59 .  To  whic h of the given options  is  RQ  63  related ,
fo l lowing the s ame logic ?fo l lowing the s ame logic ?

A nsA ns 1. XW 55

2. TU 71

3. VW 75

4. UT 71

Q .3 9Q .3 9 S ix  people U,  V,  W,  X ,  F  and G  are s itt ing around a c irc ular  table fac ing the centre of the table.  V  s its  third  to  the left  of  W.  O nly  oneS ix  people U,  V,  W,  X ,  F  and G  are s itt ing around a c irc ular  table fac ing the centre of the table.  V  s its  third  to  the left  of  W.  O nly  one
pers on s its  between W and U when c ounted from the left  of  U.  O nly  two people s it  between G  and U when c ounted from the r ight  ofpers on s its  between W and U when c ounted from the left  of  U.  O nly  two people s it  between G  and U when c ounted from the r ight  of
U.  X  is  an immediate neighbour  of G .  How many  people s it  between X and F when c ounted from the r ight  of X?U.  X  is  an immediate neighbour  of G .  How many  people s it  between X and F when c ounted from the r ight  of X?

A nsA ns 1. None

2. Three

3. One

4. Two

Q .4 0Q .4 0 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

78 78 81  81  85 85 90  90  ?  ?  1 0 31 0 3

A nsA ns 1. 96

2. 92

3. 94

4. 98

Q .4 1Q .4 1 S elec t  the mos t appropr iate meaning of the given id iom.S elec t  the mos t appropr iate meaning of the given id iom.

To beat  around the bus hTo beat  around the bus h

A nsA ns 1. To avoid the main issue

2. To act smart

3. To be around a bush

4. To beat someone

Q .4 2Q .4 2 S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group of words .S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group of words .

To be c heerful  and fr iendlyTo be c heerful  and fr iendly

A nsA ns 1. Lethargic

2. Jovial

3. Sorrowful

4. Ephemeral

Q .43Q .43 S elec t  the mos t appropr iate s y nony m of the given word .S elec t  the mos t appropr iate s y nony m of the given word .

A rc aneA rc ane

A nsA ns 1. Obvious

2. Simple

3. Mysterious

4. Clear

Section : General English and Comprehension
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Q .4 4Q .4 4 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

He ______ the doc ument c areful ly  before s igning it  y es terday .He ______ the doc ument c areful ly  before s igning it  y es terday .

A nsA ns 1. scanning

2. scanned

3. scans

4. has been scanned

Q .4 5Q .4 5 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

Des pite the ___ weather,  the team c ompleted the expedit ion.Des pite the ___ weather,  the team c ompleted the expedit ion.

A nsA ns 1. magnanimous

2. developed

3. beautiful

4. challenging

C omprehens ion:C omprehens ion:

Read the given passage below and answer the questions that follow.

During the Roman times, defeated enemies were generally put to death as criminals for having offended the Roman emperor. In the Middle Ages,
however, the practice of ransoming or returning prisoners in exchange for money, became common. For some this was a customary practice as a
step towards a more humane society. But the primary reasons behind it were economic rather than humanitarian as in those times, rulers had only
a limited ability to raise taxes. They could neither force their subjects to fight nor pay them to do so. The promise of material compensation in the
form of goods and ransom was therefore the only way of inducing combatants to participate in a war. In the Middle Ages, the predominant
incentive for the individual soldier to participate in a war was the expectation of spoils. Although collecting ransom clearly brought financial gain,
keeping a prisoner and arranging for his exchange had its costs. Consequently, several procedures were devised to reduce transaction costs.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6

Q .4 6Q .4 6 Whic h of the fo l lowing des c r ibes  the tone of the pas s age?Whic h of the fo l lowing des c r ibes  the tone of the pas s age?

A nsA ns 1. Happy

2. Factual 

3. Excitement

4. Humourous

C omprehens ion:C omprehens ion:

Read the given passage below and answer the questions that follow.

During the Roman times, defeated enemies were generally put to death as criminals for having offended the Roman emperor. In the Middle Ages,
however, the practice of ransoming or returning prisoners in exchange for money, became common. For some this was a customary practice as a
step towards a more humane society. But the primary reasons behind it were economic rather than humanitarian as in those times, rulers had only
a limited ability to raise taxes. They could neither force their subjects to fight nor pay them to do so. The promise of material compensation in the
form of goods and ransom was therefore the only way of inducing combatants to participate in a war. In the Middle Ages, the predominant
incentive for the individual soldier to participate in a war was the expectation of spoils. Although collecting ransom clearly brought financial gain,
keeping a prisoner and arranging for his exchange had its costs. Consequently, several procedures were devised to reduce transaction costs.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47

Q .47Q .47 S elec t  the mos t appropr iate A NTO NYM  of the given word ,  as  us ed in the pas s age.S elec t  the mos t appropr iate A NTO NYM  of the given word ,  as  us ed in the pas s age.

PredominantPredominant

A nsA ns 1. Primary

2. Main

3. Foremost

4. Least
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C omprehens ion:C omprehens ion:

Read the given passage below and answer the questions that follow.

During the Roman times, defeated enemies were generally put to death as criminals for having offended the Roman emperor. In the Middle Ages,
however, the practice of ransoming or returning prisoners in exchange for money, became common. For some this was a customary practice as a
step towards a more humane society. But the primary reasons behind it were economic rather than humanitarian as in those times, rulers had only
a limited ability to raise taxes. They could neither force their subjects to fight nor pay them to do so. The promise of material compensation in the
form of goods and ransom was therefore the only way of inducing combatants to participate in a war. In the Middle Ages, the predominant
incentive for the individual soldier to participate in a war was the expectation of spoils. Although collecting ransom clearly brought financial gain,
keeping a prisoner and arranging for his exchange had its costs. Consequently, several procedures were devised to reduce transaction costs.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8

Q .4 8Q .4 8 S elec t  the mos t appropr iate t it le for  this  pas s age.S elec t  the mos t appropr iate t it le for  this  pas s age.

A nsA ns 1. How to participate in a war

2. The practice of ransom in ancient times

3. Roman times better than modern times

4. Prisoners: A boon to society

C omprehens ion:C omprehens ion:

Read the given passage below and answer the questions that follow.

During the Roman times, defeated enemies were generally put to death as criminals for having offended the Roman emperor. In the Middle Ages,
however, the practice of ransoming or returning prisoners in exchange for money, became common. For some this was a customary practice as a
step towards a more humane society. But the primary reasons behind it were economic rather than humanitarian as in those times, rulers had only
a limited ability to raise taxes. They could neither force their subjects to fight nor pay them to do so. The promise of material compensation in the
form of goods and ransom was therefore the only way of inducing combatants to participate in a war. In the Middle Ages, the predominant
incentive for the individual soldier to participate in a war was the expectation of spoils. Although collecting ransom clearly brought financial gain,
keeping a prisoner and arranging for his exchange had its costs. Consequently, several procedures were devised to reduce transaction costs.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9

Q .4 9Q .4 9 Whic h of the fo l lowing des c r ibes  the main theme of the pas s age?Whic h of the fo l lowing des c r ibes  the main theme of the pas s age?

A nsA ns 1. To emphasise the importance of a warrior’s ‘word of honour’ during the Middle Ages

2. To highlight the economic basis of the medieval practice of exchanging prisoners for ransom

3. To explore three ways of reducing the costs of ransom 

4. To examine the history of the treatment of prisoners of war

C omprehens ion:C omprehens ion:

Read the given passage below and answer the questions that follow.

During the Roman times, defeated enemies were generally put to death as criminals for having offended the Roman emperor. In the Middle Ages,
however, the practice of ransoming or returning prisoners in exchange for money, became common. For some this was a customary practice as a
step towards a more humane society. But the primary reasons behind it were economic rather than humanitarian as in those times, rulers had only
a limited ability to raise taxes. They could neither force their subjects to fight nor pay them to do so. The promise of material compensation in the
form of goods and ransom was therefore the only way of inducing combatants to participate in a war. In the Middle Ages, the predominant
incentive for the individual soldier to participate in a war was the expectation of spoils. Although collecting ransom clearly brought financial gain,
keeping a prisoner and arranging for his exchange had its costs. Consequently, several procedures were devised to reduce transaction costs.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50

Q . 50Q . 50 S elec t  the mos t appropr iate s y nony m of the word ,  as  us ed in the pas s age.S elec t  the mos t appropr iate s y nony m of the word ,  as  us ed in the pas s age.

G ainG ain

A nsA ns 1. Diminish

2. Dip

3. Lose

4. Accumulate

Section : General Hindi and Comprehension
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Q . 51Q . 51 PनRSलUख तPनRSलUख त   Pवक Z[Pवक Z[   म]म]   सेसे  ‘ ‘ ता ला बता ला ब ’ ’ काका   प यd यवा चीप यd यवा ची   कौ नकौ न -- सासा   हैहै ??

A nsA ns 1. सरोवर

2. नदी

3. कृपाण

4. सुर

Q . 52Q . 52 PनRSलUख तPनRSलUख त   Pवक Z[Pवक Z[   म]म]   सेसे  ‘ ‘ उ q षsउ q षs ’ ’ काका   Pवलो मPवलो म   शuशu   कौ नकौ न -- सासा   हैहै ??

A nsA ns 1. अनुwचत

2. अपकषs

3. उxर

4. संघषs

Q . 53Q . 53 सव{ wचतसव{ wचत   अनुमPत बो धकअनुमPत बो धक   ि~ याि~ या   शuशu   सेसे   �द ए�द ए   ग एग ए   वा �वा �   काका   �र ��र �   �ा न�ा न   प ूणsप ूणs   क र]क र] --
का फ�का फ�   रा तरा त   होहो   ग ईग ई   हैहै   अबअब   मुझेमुझे  . . . . . . . . . . .  । . . . . . . . . . . .  ।

A nsA ns 1. रोको

2. पढ़ाओ

3. रहना है

4. जाने द]

Q . 54Q . 54 ‘‘ ह�थया रह�थया र   डा लडा ल   दे नादे ना ’ -  ’ -  मुहा वरेमुहा वरे   काका   अथsअथs   �ा�ा   हैहै ??

A nsA ns 1. संघषs म] Pवजय �ा� करना

2. यु� के Sलए तैयार� करना

3. हार मान लेना

4. झगड़ा करना

Q . 55Q . 55 नी चेनी चे   �द ए�द ए   अथsअथs   केके   SलएSलए   उ प यु�उ प यु�   लो को ��लो को ��   �द ए�द ए   ग एग ए   Pवक Z[Pवक Z[   म]म]   सेसे   चुPनएचुPनए । । 
सी मासी मा   केके   अंद रअंद र   का यsका यs   क र नाक र ना   चा �हएचा �हए ।।

A nsA ns 1. इतना खाए Sजतना पचे

2. इतनी सी जान, गज भर क� ज़बान

3. आसपास बरसे �द�ी पड़ी तरसे

4. आप मरे जग परलय

C omprehens ion:C omprehens ion:

PनRSलUखत ग��श के आधार पर ��[ के उxर द]।
�हदंी सा�ह  क� परंपरा म] सा�ह  के �Pतप¡ क� भूPमका म] Pनःसंदेह कबीर सबसे अहम नाम ह£। धमs और सxा क� तानाशाही, समाज म] ¥ा� भेद-भाव के Pवषैले वातावरण और कमsक�ड से
Sजस Pनभ¦कता और तािकs कता से कबीर ने मुकाबला िकया उसक� आव§कता आज वा¨Pवकता म] कह© ªादा है। �ो . गोपे«र Sसंह कबीर क� �ासं�गकता के संदभs म] Sलखते ह£ "उनक�
�ासं�गकता पर य�द हम Pवचार कर रहे ह£ तो यह जा�हर है िक सामा­ तौर पर एक भले और अ®े आदमी से वे लाख गुना अ®े और आगे के आदमी थे। हमारे समय म] �हदंू-मुसलमान क�
सम¯ा Sजतनी भयावह है, वह कबीर के समय से अ�धक है। हमारा समय कबीर के समय से अ�धक अस�ह°ु है। वे आज होते तो उ±] अपनी साUखय² कहने म] हजार परेशाPनय² उठानी
पड़त©।"3 �ो . Sसंह का यह बयान आज के Pनमsम समय और खौफनाक सच का बयान है। स��दा�यक श��य[ के मजबूत होते हौसले और सामाSजक[ के बीच बढ़ती अस�ह°ुता इस बात क�
त´ीक करते ह£। इस �कार Pनःसंदेह कबीर क� �ासं�गकता और नए संदभµ म] उनक� ¥ा¶ा आज के मानव समाज क� अतीव आव§कता है।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56

Q . 56Q . 56 ग �� शग �� श   केके   आ धा रआ धा र   प रप र   उ x रउ x र   द]द] ।।
क बी रक बी र   केके   संद भsसंद भs   म]म]   वतsमा नवतsमा न   मा नवमा नव   समा जसमा ज   केके   SलएSलए   �ा�ा   आ व§कआ व§क   हैहै ??

A nsA ns 1. नए संदभµ म] कबीर क� ¥ा¶ा

2. स��दा�यक श��य[ को काबू िकया जाना चा�हए

3. स��दा�यक स�ह°ुता को बढ़ाना चा�हए

4. कबीर क� साUखय² पुनः  Sलखी जानी चा�हए
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C omprehens ion:C omprehens ion:

PनRSलUखत ग��श के आधार पर ��[ के उxर द]।
�हदंी सा�ह  क� परंपरा म] सा�ह  के �Pतप¡ क� भूPमका म] Pनःसंदेह कबीर सबसे अहम नाम ह£। धमs और सxा क� तानाशाही, समाज म] ¥ा� भेद-भाव के Pवषैले वातावरण और कमsक�ड से
Sजस Pनभ¦कता और तािकs कता से कबीर ने मुकाबला िकया उसक� आव§कता आज वा¨Pवकता म] कह© ªादा है। �ो . गोपे«र Sसंह कबीर क� �ासं�गकता के संदभs म] Sलखते ह£ "उनक�
�ासं�गकता पर य�द हम Pवचार कर रहे ह£ तो यह जा�हर है िक सामा­ तौर पर एक भले और अ®े आदमी से वे लाख गुना अ®े और आगे के आदमी थे। हमारे समय म] �हदंू-मुसलमान क�
सम¯ा Sजतनी भयावह है, वह कबीर के समय से अ�धक है। हमारा समय कबीर के समय से अ�धक अस�ह°ु है। वे आज होते तो उ±] अपनी साUखय² कहने म] हजार परेशाPनय² उठानी
पड़त©।"3 �ो . Sसंह का यह बयान आज के Pनमsम समय और खौफनाक सच का बयान है। स��दा�यक श��य[ के मजबूत होते हौसले और सामाSजक[ के बीच बढ़ती अस�ह°ुता इस बात क�
त´ीक करते ह£। इस �कार Pनःसंदेह कबीर क� �ासं�गकता और नए संदभµ म] उनक� ¥ा¶ा आज के मानव समाज क� अतीव आव§कता है।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57

Q . 57Q . 57 उ प रो �उ प रो �   ग �� शग �� श   हेत ुहेत ु   उ wचतउ wचत   शी ष sकशी षsक   काका   चयनचयन   क र]क र] ।।

A nsA ns 1. सामाSजक Pव·ेष

2. कबीर और स��दा�यकता

3. समाज के Pव�भ¸ सं�दाय

4. कबीर के दोहे

C omprehens ion:C omprehens ion:

PनRSलUखत ग��श के आधार पर ��[ के उxर द]।
�हदंी सा�ह  क� परंपरा म] सा�ह  के �Pतप¡ क� भूPमका म] Pनःसंदेह कबीर सबसे अहम नाम ह£। धमs और सxा क� तानाशाही, समाज म] ¥ा� भेद-भाव के Pवषैले वातावरण और कमsक�ड से
Sजस Pनभ¦कता और तािकs कता से कबीर ने मुकाबला िकया उसक� आव§कता आज वा¨Pवकता म] कह© ªादा है। �ो . गोपे«र Sसंह कबीर क� �ासं�गकता के संदभs म] Sलखते ह£ "उनक�
�ासं�गकता पर य�द हम Pवचार कर रहे ह£ तो यह जा�हर है िक सामा­ तौर पर एक भले और अ®े आदमी से वे लाख गुना अ®े और आगे के आदमी थे। हमारे समय म] �हदंू-मुसलमान क�
सम¯ा Sजतनी भयावह है, वह कबीर के समय से अ�धक है। हमारा समय कबीर के समय से अ�धक अस�ह°ु है। वे आज होते तो उ±] अपनी साUखय² कहने म] हजार परेशाPनय² उठानी
पड़त©।"3 �ो . Sसंह का यह बयान आज के Pनमsम समय और खौफनाक सच का बयान है। स��दा�यक श��य[ के मजबूत होते हौसले और सामाSजक[ के बीच बढ़ती अस�ह°ुता इस बात क�
त´ीक करते ह£। इस �कार Pनःसंदेह कबीर क� �ासं�गकता और नए संदभµ म] उनक� ¥ा¶ा आज के मानव समाज क� अतीव आव§कता है।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58

Q . 58Q . 58 उ प रो �उ प रो �   ग �� शग �� श   केके   आ धा रआ धा र   प रप र   PनRSलUख तPनRSलUख त   म]म]   सेसे   कौ नसाकौ नसा   वा �वा �   अस अस    हैहै ??

A nsA ns 1. कबीर का समय अ�धक अस�ह°ु था।

2. वतsमान समाज म] कबीर क� आव§कता है।

3. कबीर क� ¥ा¶ा नए संदभµ क� जानी आव§क है।

4. स��दा�यक Pव·ेष आज पहले से अ�धक है।

C omprehens ion:C omprehens ion:

PनRSलUखत ग��श के आधार पर ��[ के उxर द]।
�हदंी सा�ह  क� परंपरा म] सा�ह  के �Pतप¡ क� भूPमका म] Pनःसंदेह कबीर सबसे अहम नाम ह£। धमs और सxा क� तानाशाही, समाज म] ¥ा� भेद-भाव के Pवषैले वातावरण और कमsक�ड से
Sजस Pनभ¦कता और तािकs कता से कबीर ने मुकाबला िकया उसक� आव§कता आज वा¨Pवकता म] कह© ªादा है। �ो . गोपे«र Sसंह कबीर क� �ासं�गकता के संदभs म] Sलखते ह£ "उनक�
�ासं�गकता पर य�द हम Pवचार कर रहे ह£ तो यह जा�हर है िक सामा­ तौर पर एक भले और अ®े आदमी से वे लाख गुना अ®े और आगे के आदमी थे। हमारे समय म] �हदंू-मुसलमान क�
सम¯ा Sजतनी भयावह है, वह कबीर के समय से अ�धक है। हमारा समय कबीर के समय से अ�धक अस�ह°ु है। वे आज होते तो उ±] अपनी साUखय² कहने म] हजार परेशाPनय² उठानी
पड़त©।"3 �ो . Sसंह का यह बयान आज के Pनमsम समय और खौफनाक सच का बयान है। स��दा�यक श��य[ के मजबूत होते हौसले और सामाSजक[ के बीच बढ़ती अस�ह°ुता इस बात क�
त´ीक करते ह£। इस �कार Pनःसंदेह कबीर क� �ासं�गकता और नए संदभµ म] उनक� ¥ा¶ा आज के मानव समाज क� अतीव आव§कता है।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59

Q . 59Q . 59 PनRSलUख तPनRSलUख त   Pवक Z[Pवक Z[   म]म]   सेसे   कौ नसाकौ नसा   Pवक ZPवक Z  ' ' सा मा ­सा मा ­ '  '  शuशu   काका   Pवलो मPवलो म   शuशu   हैहै ??

A nsA ns 1. PवSश¹

2. क�ठन

3. संदेह

4. Pव·ेष
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C omprehens ion:C omprehens ion:

PनRSलUखत ग��श के आधार पर ��[ के उxर द]।
�हदंी सा�ह  क� परंपरा म] सा�ह  के �Pतप¡ क� भूPमका म] Pनःसंदेह कबीर सबसे अहम नाम ह£। धमs और सxा क� तानाशाही, समाज म] ¥ा� भेद-भाव के Pवषैले वातावरण और कमsक�ड से
Sजस Pनभ¦कता और तािकs कता से कबीर ने मुकाबला िकया उसक� आव§कता आज वा¨Pवकता म] कह© ªादा है। �ो . गोपे«र Sसंह कबीर क� �ासं�गकता के संदभs म] Sलखते ह£ "उनक�
�ासं�गकता पर य�द हम Pवचार कर रहे ह£ तो यह जा�हर है िक सामा­ तौर पर एक भले और अ®े आदमी से वे लाख गुना अ®े और आगे के आदमी थे। हमारे समय म] �हदंू-मुसलमान क�
सम¯ा Sजतनी भयावह है, वह कबीर के समय से अ�धक है। हमारा समय कबीर के समय से अ�धक अस�ह°ु है। वे आज होते तो उ±] अपनी साUखय² कहने म] हजार परेशाPनय² उठानी
पड़त©।"3 �ो . Sसंह का यह बयान आज के Pनमsम समय और खौफनाक सच का बयान है। स��दा�यक श��य[ के मजबूत होते हौसले और सामाSजक[ के बीच बढ़ती अस�ह°ुता इस बात क�
त´ीक करते ह£। इस �कार Pनःसंदेह कबीर क� �ासं�गकता और नए संदभµ म] उनक� ¥ा¶ा आज के मानव समाज क� अतीव आव§कता है।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60

Q .60Q .60 PनRSलUख तPनRSलUख त   Pवक Z[Pवक Z[   म]म]   सेसे   कौ नसाकौ नसा   Pवक ZPवक Z  ' ' क मsक मs '  '  शuशu   काका   प यd यवा चीप यd यवा ची   शuशu   नह©नह©   हैहै ??

A nsA ns 1. काज

2. ि~या

3. कृ 

4. काठ

Q .61Q .61 Whic h of the fo l lowing menus  has  page or ientat ion in M S - Word?Whic h of the fo l lowing menus  has  page or ientat ion in M S - Word?

A nsA ns 1. Insert

2. Page Layout

3. Review

4. File

Q .62Q .62 What is  the purpos e of a  rans omware v irus?What is  the purpos e of a  rans omware v irus?

A nsA ns 1. To display ads on the system

2. To lock users out of their files or system and demand payment for access

3. To remove other viruses from the system

4. To speed up system performance

Q .63Q .63

A nsA ns 1. 

2. 

3. 

4. 

Q .64Q .64 Whic h of the fo l lowing key board s hortc uts  is  us ed to  pr int  a  web page in G oogle C hrome in the Windows  O S ?Whic h of the fo l lowing key board s hortc uts  is  us ed to  pr int  a  web page in G oogle C hrome in the Windows  O S ?

A nsA ns 1. Ctrl + Alt + P

2. Ctrl + P

3. Alt + P

4. Shift + P

Q .65Q .65

A nsA ns 1. 

2. 

3. 

4. 

Q .66Q .66 If  a  us er  wants  to  c orrec t  a  mis s pelt  word d irec t ly  from the doc ument ins tead of the S pel l ing and G rammar d ia log box ,  what s houldIf  a  us er  wants  to  c orrec t  a  mis s pelt  word d irec t ly  from the doc ument ins tead of the S pel l ing and G rammar d ia log box ,  what s hould
they  do?they  do?

A nsA ns 1. Close the spell checker.

2. Add the word to the dictionary.

3. Use the 'Ignore' button in the dialog box.

4. Click on the word in the document and edit it.

Section : Basic Knowledge of Computer
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Q .67Q .67 How c an the M S  Word proofing s ett ings  be a ltered to  c hec k  for  part ic ular  grammar rules ,  l ike the us e of c ommas  or  pas s ive vo ice?How c an the M S  Word proofing s ett ings  be a ltered to  c hec k  for  part ic ular  grammar rules ,  l ike the us e of c ommas  or  pas s ive vo ice?

A nsA ns 1. Use the 'References' tab and click 'Check Grammar'

2. Navigate to 'File' > 'Options' > 'Proofing' > 'Settings'

3. Go to 'Review' tab and click 'Set Language'

4. Right-click a flagged error and select 'Grammar Settings'

Q .68Q .68 How c an us ers  maintain the as pec t  rat io  of  a  C l ip A rt  image whi le res iz ing it  in M S  PowerPoint?How c an us ers  maintain the as pec t  rat io  of  a  C l ip A rt  image whi le res iz ing it  in M S  PowerPoint?

A nsA ns 1. Right-click and select 'Fix Ratio'

2. Press the Shift key while dragging a corner handle

3. Use 'File' > 'Save As'

4. Press the Ctrl key while dragging a handle

Q .69Q .69 The ful l  form of IM A P in the c ontext  of  emai l  c l ient  c onfigurat ion is  _______ .The ful l  form of IM A P in the c ontext  of  emai l  c l ient  c onfigurat ion is  _______ .

A nsA ns 1. Internal Mail Administration Protocol

2. Internet Message Access Protocol

3. Internet Main Access Protocol

4. Integrated Mail Access Protocol

Q .70Q .70 What happens  if  y ou us e the 'C lear  A l l  Formatt ing'  opt ion?What happens  if  y ou us e the 'C lear  A l l  Formatt ing'  opt ion?

A nsA ns 1. It resets text to the default style and removes all formatting.

2. It removes the entire document.

3. It only removes bold and italic formatting.

4. It saves the document.
            

Q .71Q .71 Whic h of the fo l lowing way s  is  NO T us eful  for  s ec ur ing a PC ?Whic h of the fo l lowing way s  is  NO T us eful  for  s ec ur ing a PC ?

A nsA ns 1. Use antivirus softwares

2. Use firewall

3. Use strong password

4. Use free Wi-Fi

Q .72Q .72 Whic h of the fo l lowing is  a  c ommon tec hnique for  acces s ing the internet?Whic h of the fo l lowing is  a  c ommon tec hnique for  acces s ing the internet?

A nsA ns 1. Bluetooth

2. Dial-up

3. USB

4. NFC

Q .73Q .73 Whic h of the fo l lowing s teps  a l lows  y ou to  ins ert  a  C l ip A rt  image into  a  PowerPoint  s l ide?Whic h of the fo l lowing s teps  a l lows  y ou to  ins ert  a  C l ip A rt  image into  a  PowerPoint  s l ide?

A nsA ns 1. Click the 'Insert' tab, then select 'Online Pictures' or 'Clip Art'

2. Use the 'Format' tab and select 'Clip Art'

3. Right-click on the slide and select 'Insert Clip'

4. Open the 'Design' tab and choose 'Add Art'

Q .74Q .74 Whic h func t ion would  y ou us e to  c reate a  c us tom date s er ies  that  inc rements  by  quarters  (e.g . ,  Jan 1 ,  A pr  1 ,  Jul  1 ,  O c t  1 ) ?Whic h func t ion would  y ou us e to  c reate a  c us tom date s er ies  that  inc rements  by  quarters  (e.g . ,  Jan 1 ,  A pr  1 ,  Jul  1 ,  O c t  1 ) ?

A nsA ns 1. EDATE with a step value of 3

2. WORKDAY with a step value of 3

3. DATE

4. SEQUENCE with a step value of 3

Q .75Q .75 Whic h of the fo l lowing key board s hortc uts  is  us ed to  undo the las t  ac t ion in M S  Word?Whic h of the fo l lowing key board s hortc uts  is  us ed to  undo the las t  ac t ion in M S  Word?

A nsA ns 1. Ctrl+X

2. Ctrl+C

3. Ctrl+Z

4. Ctrl+Y
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Q .76Q .76

A nsA ns 1. 

2. 

3. 

4. 

Q .77Q .77

A nsA ns 1. 

2. 

3. 

4. 

Q .78Q .78 Whic h of the fo l lowing c ommands  c an be us ed to  open the Windows  Features  window?Whic h of the fo l lowing c ommands  c an be us ed to  open the Windows  Features  window?

A nsA ns 1. optional features

2. win + R

3. control features.cpl

4. Windows Features

Q .79Q .79 Whic h of the fo l lowing bes t  des c r ibes  the ro le of  a  s y s tem s oftware in relat ion to  appl ic at ion s oftware?Whic h of the fo l lowing bes t  des c r ibes  the ro le of  a  s y s tem s oftware in relat ion to  appl ic at ion s oftware?

A nsA ns 1. System software provides a platform for running application software.

2. System software is designed to create new applications.

3. System software replaces the need for application software.

4. System software is used to enhance the user interface of application software.

Q .80Q .80 Whic h of the fo l lowing options  is  NO T a c ons iderat ion when pr int ing web pages  from a brows er?Whic h of the fo l lowing options  is  NO T a c ons iderat ion when pr int ing web pages  from a brows er?

A nsA ns 1. Printing header and footer information, such as page numbers and URL

2. Selecting the printer and specifying the number of copies to print

3. Page setup settings, such as orientation and margins

4. Font size and color adjustments for better readability

Q .81Q .81 What is  the average s peed of a  c ar  whic h c overs  half  the d is tance with a  s peed of 3 5 km/ hr  and the other  half  with a  s peed of 63What is  the average s peed of a  c ar  whic h c overs  half  the d is tance with a  s peed of 3 5 km/ hr  and the other  half  with a  s peed of 63
km/ hr?km/ hr?

A nsA ns 1. 45 km/hr

2. 47 km/hr

3. 38 km/hr

4. 43 km/hr

Q .82Q .82 The firs t  part  of  a  journey  is  c overed in 6  h at  a  s peed of 1 0 0  km/ hr  and the remaining part  of  the journey  is  c overed in 3  h and 2 0The firs t  part  of  a  journey  is  c overed in 6  h at  a  s peed of 1 0 0  km/ hr  and the remaining part  of  the journey  is  c overed in 3  h and 2 0
min at  72  km/ hr.  What is  the average s peed ( in km/ hr)  for  the ent ire journey ?min at  72  km/ hr.  What is  the average s peed ( in km/ hr)  for  the ent ire journey ?

A nsA ns 1. 72

2. 90

3. 84

4. 96

Q .83Q .83

A nsA ns 1. 35,000

2. 30,000

3. 25,000

4. 20,000

Section : Quantitative Aptitude
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Q .84Q .84 O n the bas is  of  his  exper ience,  a  c ontrac tor  es t imates  that  3  workers  c an d ig a  wel l  of  s uitable depth and d iameter  in a  farmhous eO n the bas is  of  his  exper ience,  a  c ontrac tor  es t imates  that  3  workers  c an d ig a  wel l  of  s uitable depth and d iameter  in a  farmhous e
in 4  day s .  To  finis h this  work  ear ly ,  he engages  4  workers .  How many  day s  wi l l  they  take to  finis h the work?in 4  day s .  To  finis h this  work  ear ly ,  he engages  4  workers .  How many  day s  wi l l  they  take to  finis h the work?

A nsA ns 1. 3.5 days

2. 2.5 days

3. 3 days

4. 2 days

Q .85Q .85 S ix  y ears  ago from the pres ent age,  Radha was  thr ice as  o ld  as  P ink i .  Twelve y ears  later  from pres ent age,  Radha wi l l  be twice as  o ldS ix  y ears  ago from the pres ent age,  Radha was  thr ice as  o ld  as  P ink i .  Twelve y ears  later  from pres ent age,  Radha wi l l  be twice as  o ld
as  P ink i .  What are the pres ent ages  of P ink i  and Radha,  res pec t ively ?as  P ink i .  What are the pres ent ages  of P ink i  and Radha,  res pec t ively ?

A nsA ns 1. 14 years and 42 years

2. 17 years and 85 years

3. 19 years and 65 years

4. 24 years and 60 years

Q .86Q .86 In an elec t ion between two c andidates ,  96% of the regis tered voters  c as t  their  vote and 1 5% of the votes  pol led  were found inval id .In an elec t ion between two c andidates ,  96% of the regis tered voters  c as t  their  vote and 1 5% of the votes  pol led  were found inval id .
The winning c andidate got  56% of the val id  votes  and won the elec t ion by  a  margin of 1 53 0  votes .  How many  voters  wereThe winning c andidate got  56% of the val id  votes  and won the elec t ion by  a  margin of 1 53 0  votes .  How many  voters  were
regis tered?regis tered?

A nsA ns 1. 15625

2. 15624

3. 15627

4. 15628

Q .87Q .87 In a  tes t ,  the average s c ore of 50  s tudents  in a  c las s  is  63.  O ut of the total  s tudents ,  50 % are gir ls  and the res t  are boy s .  TheIn a  tes t ,  the average s c ore of 50  s tudents  in a  c las s  is  63.  O ut of the total  s tudents ,  50 % are gir ls  and the res t  are boy s .  The
average s c ore of the boy s  is  2 0 % les s  than that  of the gir ls .  F ind the average s c ore of the gir ls .average s c ore of the boy s  is  2 0 % les s  than that  of the gir ls .  F ind the average s c ore of the gir ls .

A nsA ns 1. 65

2. 54

3. 56

4. 70

Q .88Q .88

A nsA ns 1. 

2. 

            

3. 

           

4. 

           

Q .89Q .89 E valuate the fo l lowing:E valuate the fo l lowing:

3 5 − [ 2 5 − { 3 1  − ( 2 2  − 1 2  + 8) } ]3 5 − [ 2 5 − { 3 1  − ( 2 2  − 1 2  + 8) } ]

A nsA ns 1. 23

2. 20

3. 22

4. 26
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Q .91Q .91

A nsA ns 1. −14.7

2. 12.6

3. 0

4. −8.5

Q .92Q .92 5 men and 6  women c an do a piece of work  in 6  day s  whi le 3  men and 5 women c an do the s ame work  in 9  day s .  In how many  day s5 men and 6  women c an do a piece of work  in 6  day s  whi le 3  men and 5 women c an do the s ame work  in 9  day s .  In how many  day s
c an 3  men and 2  women do the s ame work?c an 3  men and 2  women do the s ame work?

A nsA ns 1. 

2. 

3. 

4. 

Q .93Q .93

A nsA ns 1. 88.5% 

2. 90.6% 

3. 86.3% 

4. 87.6% 

Q .94Q .94

A nsA ns 1. 

2. 

3. 

4. 

Q .95Q .95 The marked pr ice of an art ic le is  ₹1 ,2 0 0 .  The s el ler  gives  three s ucces s ive d is c ounts  of 2 0 %, 1 0 % and 5%, res pec t ively .  F ind itsThe marked pr ice of an art ic le is  ₹1 ,2 0 0 .  The s el ler  gives  three s ucces s ive d is c ounts  of 2 0 %, 1 0 % and 5%, res pec t ively .  F ind its
s el l ing pr ice.s el l ing pr ice.

A nsA ns 1. ₹800.80

2. ₹860.80

3. ₹820.80

4. ₹880.80

Q .96Q .96 If  the pr ice of a  c omputer  s c reen is  firs t  inc reas ed by  1 5% and then inc reas ed by  2 0 %, then the res ult ing percentage inc reas e inIf  the pr ice of a  c omputer  s c reen is  firs t  inc reas ed by  1 5% and then inc reas ed by  2 0 %, then the res ult ing percentage inc reas e in
pr ice wi l l  be:pr ice wi l l  be:

A nsA ns 1. 25%

2. 30%

3. 32%

4. 38%
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Q .97Q .97 If  the radius  of a  c y l inder  is  reduced by  half  and the height is  inc reas ed by  four  t imes ,  what wi l l  be the net  c hange in the vo lume?If  the radius  of a  c y l inder  is  reduced by  half  and the height is  inc reas ed by  four  t imes ,  what wi l l  be the net  c hange in the vo lume?

A nsA ns 1. The new volume will be decreased by 20%.

2. There will be no change in the volume.

3. The new volume will be 15% of the original volume.

4. The new volume will be increased by 25%.

Q .98Q .98 The average of the marks  of 1 5 s tudents  in a  c las s  is  50 .  I f  the marks  of eac h s tudent are doubled ,  find the new average.The average of the marks  of 1 5 s tudents  in a  c las s  is  50 .  I f  the marks  of eac h s tudent are doubled ,  find the new average.

A nsA ns 1. 100

2. 30

3. 15

4. 50

Q .99Q .99 A  retai ler  buy s  an elec tronic  item for  ₹1 80 .  H is  overhead expens es  are ₹2 0 .  He s el ls  the elec tronic  item for  ₹3 2 0  and makes  x%A  retai ler  buy s  an elec tronic  item for  ₹1 80 .  H is  overhead expens es  are ₹2 0 .  He s el ls  the elec tronic  item for  ₹3 2 0  and makes  x%
profit .  The value of x  is :profit .  The value of x  is :

A nsA ns 1. 50

2. 60

3. 40

4. 80

Q .1 0 0Q .1 0 0 5 t imes  the pres ent age of Renu is  1 3  y ears  more than 8  t imes  the pres ent age of M anav,  and 9  t imes  the pres ent age of M anav is  95 t imes  the pres ent age of Renu is  1 3  y ears  more than 8  t imes  the pres ent age of M anav,  and 9  t imes  the pres ent age of M anav is  9
y ears  les s  than 5 t imes  the pres ent age of Renu.  The s um of the pres ent ages  ( in y ears)  of  Renu and M anav is :y ears  les s  than 5 t imes  the pres ent age of Renu.  The s um of the pres ent ages  ( in y ears)  of  Renu and M anav is :

A nsA ns 1. 17

2. 11

3. 15

4. 13
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